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PROCESS MAPS AND USEFUL NOTES 
 
The following are available on the available on the SITS website > Course Notes page: 
 

 Mark entry process map (or in Appendix 2). 
 
SMRU screen: 

 modifying and undoing calculated marks and grades (process map) 

 complete process notes  

MODULE ASSESSMENT SET UP — MAV, MAP AND MAB SCREENS 
 
The Module Availability (MAV) record specifies which modules are running in which academic years. In 
order to register a student onto a module (in the SMO screen), a MAV record must exist in the 
appropriate year. If a student is not registered against a module, results cannot be entered against the 
student’s record. 
 
To determine if a module is running in a given year, go to the MAV screen and retrieve on the module 
code/prefix and/or academic year: 
 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitscoursenotes/Mark_entry_process_map_-_last_updated_091213.pdf
http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitshowto/SMRU_process_maps_240414.pdf
http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitshowto/Using_the_SMRU_screen_to_modify_or_undo_calculated_marks_-_process_notes_240414.pdf
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Press F5 to retrieve: 
 

 
 
Once the MAV has been set up, a Module Assessment Pattern (MAP) record is created which indicates 
the version of the module assessment pattern (e.g. a value that matches the module code implies that the 
module has always been assessed the same way whereas a .2 version implies that the module is being 
assessed differently than in previous years). The assessment pattern value is referred to as the MAP code. 
 
The MAP code is present on the MAV record, in the Ass Pattern field. You can double-click on that value 
to access the MAP screen. See details in the section below entitled Accessing the MAB record/Viewing the 
assessment components attached to a module. 
 
Based on the module descriptor, assessment components will be set up against the MAP code, in the 
Module Assessment Body (MAB) screen. 
 
The records in the MAB screen represent the individual assessment components for a module, including 
the initial and reassessment components. Marks will be entered for these components. 
For example: 
 

 A module is assessed by a lab session (20% of overall mark), an essay (40%) and an exam (40%).  

 Each of these components must have an entry in the MAB screen.  

 Each MAB contributes its given percentage weighting to the overall mark for the module – these 
must total 100%. 

 
If you think any changes are needed to the MAB record, check the following before making any changes: 
 

 Change in module assessment set up after SMR records generated and/or marks have been 
entered (within this document); or  

 Module Assessment and Reassessment Set Up course notes on the SITS Course Notes page. 
 
 

Accessing the MAB record / Viewing the assessment components attached to a 
module 
 
To access the correct MAB record for a given academic year, i.e. ensure that you are viewing the correct 
assessment pattern for a given academic year: 
 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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1. Retrieve the correct MAV record and then double-click on the value in the Ass Pattern field: 
 

 

2. Say Yes to the message that appears in the dialog box:   
 
You are brought to the Module Assessment Pattern (MAP screen) for the module. Then go to Other > 
Assessment Body.  
 

 
 
4.  You are brought to the Module Assessment Body (MAB): 
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In the example above the module ARC1000B is assessed by 60% exam and 40% essay. This will mean that 
for each student on the module SITS will allow two component marks to be entered. 
 
Complete details on how to complete/maintain this screen and the functions of each of the fields are 
included in the Module Assessment and Reassessment Set Up course notes on the SITS Course Notes 
page. 
 

STUDENT MODULE RESULTS — SMR SCREEN 
 
Students’ results, as entered in the mark entry screens (SAS for initial assessments and RAS for 
reassessments), are held in the SMR screen. You can navigate directly to the SMR screen to perform a 
search:   
 

 
 
You can also view an individual student’s SMR record via SPR > Other > Module > Results. 
 

Fields within the SMR screen 
 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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Field name Value / Description 
 

Student (SPR) Student SPR code 

Year Academic year module was taken in, as per the corresponding SMO record 

Prd Period the module ran in (e.g. TERM2, TRM1+2), , as per the corresponding SMO record 

Module Module code, , as per the corresponding SMO record 

Occurrence Normally A for Exeter or T for Tremough, as per the corresponding SMO record 
 

Level Level/stage of study of the student taking the module, as per the corresponding SMO 
record. 

Atmpt Cu Student’s current attempt at the module: 

 1 = initial attempt (including deferred attempt) 

 2 = second/referred attempt (for capped module result) 
 

Atmpt Co Student’s current completion rate for the module: 

 0 = no attempts completed for the module  

 1 = 1 attempt completed at the module (either initial or deferred attempt — see Status 
SAS field to determine if initial or deferred) 

 2 = 2 attempts completed at the module (referred attempt is 2nd attempt) 

Act Mark + Gr The (actual) module mark and grade as calculated by SITS based on marks entered in SAS. 

Agr Mark + Gr The (agreed) module mark and grade as calculated by SITS based on marks entered in SAS 
or as modified in SMRU following academic discretion *   
 
This is the mark and grade used for awarding/transcript purposes. 
 
It may not always match the Actual Mark or Grade (and that’s ok). 
 

Crdts Credits awarded for module. 
 

Rlt Final module result — pass (P) or fail (F) or deferral (D) 
 

Status SAS Where the results are sitting/were last processed: 

 A = in SAS (initial attempt) 

 H = held  

 R = in RAS (as referred or deferred attempt) 
 

Status PRC Current status of the process: 

 A = completed 

 C = calculated 

 H = held 
 

Cur Pro Current status of the module: 

 SAS = module at initial status (at point of mark entry in SAS). 

 RAS = module at reassessment status (both deferral and referral — marks awaiting to 
be entered in RAS) 

 COM = module attempt completed (either attempt 1 or 2) 

 
*  Please note that it is possible to use the Actual and Agreed Mark and Grades to show where a Mark or 

Grade has been altered, either due to academic discretion, mitigation or academic misconduct, etc.   
 
What is important to remember is that only the Agreed Mark and Grade are used for awarding 
students their degrees and for transcript purposes. 
 
Details on how to alter Agreed Marks and/or Grades can be found in the section entitled Changing 
marks via the SMRU screen. 
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Examples of SMR records 
 
Examples of different SMR records and how to interpret them on can be found in the Understanding 
Student Module Result records document on the SITS How To and FAQs page. 

 
Viewing the assessment component records 
 
Student Assessment Table [SAT]  
 
To view any entered component marks (only) for a student at their initial attempt: 
 
1. Go to the SMR screen and retrieve the module(s) and/or student(s).   

 

 
 

2. Highlight the SMR record you are interested in viewing assessment records for. 
 

3. Select Other > Assessment.   
 

4. This will take you to the Student Assessment Table (SAT): 
 

 
 

This screen is useful for locating the student’s candidate number for a given academic year, as students 
are issued with a new candidate number for each year of study. 
 
Note: You can also go directly to SAT, or from SPR go Other > Module > Assessments to view all 
assessments for that student. 
 
 
Student Module Result 2 [SMR > Other > Assessment Status] 
 

http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitsfaq/Understanding_SMR_records.pdf
http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitsfaq/Understanding_SMR_records.pdf
http://as.exeter.ac.uk/it/systems/sits/howdoi/howtoandfaqs/
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As well as viewing assessments through SAT you can also get a complete overview of the entire module 
(all attempts) by going to: 
 
1. Go to the SMR screen and retrieve the module(s) and/or student(s). 

   
2. Highlight the SMR record you wish to view. 

 

 
 

3. Select Other > Assessment Status   
 

 
 

 The top line will give you the overall module result information (i.e. SMR data). In the above 
example, the mark of 40% represents the final module mark after the 2nd/referred attempt. 
 

 The left-hand section will display the initial assessment information (i.e. SAT data). 
 

 The right-hand section will display the reassessment information (i.e. SRA data).  
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 In all instances, clicking on any component will display the component name in the white message 
line in the bottom left-hand corner.  
 

PREPARING TO ENTER MARKS (STEP 1) 
 

Recounting how many students are on a module — RMA1 
 
Performing this task ensures that the number of students registered against the module in SMO matches 
the number of students registered against the module in MAV (Actual field). These numbers can differ if 
the MAV was created a certain way. It ensures that all the right students appear in the Mark Entry screen. 
 
Note: The below task is not necessary unless you are generating SMR records (SAS option 1b) for students 
in a previous or future academic year as a nightly process updates the MAV Actual data for the current 
academic year based on the SMO records. 
 
Before you start the mark entry process for a module, it is advisable to recount how many students are 
registered on a module. This will double-check that any students that have changed modules late in the 
day are on the modules they should be on in SITS.  
 
To recount the number of students on a module: 
  
1. Go to the RMA screen. 
2. Complete the following fields: 

 
Field name Value to be entered 

Year Current academic year (e.g. 2014/5) 

Period Optional – enter period of module (TERM1, TERM 2, etc.) 

Level Optional – enter level of module (1 or 2, etc.) 

Module Enter a module code OR use the goldstar to run on a group of modules (e.g. ARC·*) 

 

   OR 

                                                           
1 This section relates to step 1 on the Mark Entry process map in Appendix 3. 
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3. Run the ‘Update actual’ option (click green arrow button). 
 

4. The following message will appear in the message buffer once the operation is complete 

 
 

5. If there was a discrepancy between the total number of students attached to the module in SMO vs. 
the Actual field in MAV, the value in the Actual field will have been updated as needed. 
 

It is possible to produce a list of actual module numbers via option 5 on the SRM screen (for more details 
see the section entitled ‘Producing a report on module numbers’ in the Module Data Set Up course 
notes). 
 

CREATING THE SMR RECORDS — SAS OPTION 1B2 (STEP 2) 
 
In order to be able to enter module component marks for students (in SAS option 3), you must first 
generate the blank SMR [Student Module Result] records.  SITS will generate the components to enter 
marks against based on the MAB record for this module. 

 
How to determine if the SMR records have been generated 
 
When you try to retrieve on the module code and academic year in the SMR screen: 
 
1. no records are retrieved — SMR records have not been generated. 

 

 

 
 
2. records are retrieved (something appears on the screen) — SMR records have been generated. 

 

                                                           
2 This section refers to step 2 on the Mark Entry process map in Appendix 3. 

http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitscoursenotes/2_1_Module_data_set-up_v8.6.1.0_-_last_updated_240114.pdf
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OR 

 

 
 
How to generate the SMR records to allow marks to be entered: 
 
1. Go to the SAS screen. 
2. Complete the following fields:     
 

Field name Value to be entered 

Year Current academic year (e.g. 2014/5) 

Period Optional – enter period of module (TERM1, TERM 2, etc.) 

Level Optional – enter level of module (1 or 2, etc.) 

Module Enter a specific module code or use the wildcards to run the process for a group of 
modules (e.g. ARC1Gold*) 
 
Note: Do not run the process for all your College’s modules in one go as it will make the 
output report difficult to read 

Occurrence  
(from MAV) 

Optional — Gold* 

Assessment 
Sequence Number 

Optional — Gold* or specify a specific sequence number (refers to your MAB sequence 
number – see Assessment set-up process manual) 

 
3. Run option 1b. 

 

Quick tip!  To only generate the SMR record for one specific student (e.g. student added to the 
module later, once SMR records generated for all other students), complete the white box in option 
1b with the student’s SPR number and run option 1b. 
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4. You will get a message similar to the one shown below, which informs you of how many MAV records 
are selected and how many students are enrolled on that module on SMO (or how many you are 
generating the records for): 

 

 
 

If the numbers displayed on this message are not equal to the number of students you have 
marks for, it is likely to be due to students having withdrawn or interrupted during the year (and 
who are still listed on the module in SMO). 
 

5. Click on the OK button. The following window will be displayed, as will the process status in the 
message line at the bottom of your screen. 
 

 
 

6. A message similar to the one displayed below will be shown: 
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The above message means that 171 SMR records are generated (171 students on the module). 
 

Note: If you have already input results for one assessment component and are trying to regenerate 
the SMR records, you will notice that the bottom line will mention how many records could not be 
regenerated because they already exist and contain results. This process ensures that no previously 
entered results are being overwritten or deleted. 
 

7. Click Clear & Close button to close the Message Buffer. 
 

Your SMR records have now been created, allowing you to enter marks for these students.  
 

ENTERING MARKS — SAS OPTION 3 (STEP 3)3 
 
Once you have generated the SMR record, you can start entering component marks (based on the module 
set-up in MAB).  A component = individual assessment (e.g. exam, essay, etc.) 
 

How to enter marks 
 
1. Go to the SAS screen. 
2. Complete the following fields: 
 

Field name Value to be entered 

Year Academic year (e.g. 2014/5) 

Period Optional – enter period of module (TERM1, TERM 2, etc.) 

Level Optional – enter level of module (1 or 2, etc.) 

Module Enter a specific module code or use the wildcards to run the process for a group of 
modules (e.g. ARC1·*) 
 
Note: Do not run the process for all your College’s modules in one go as it will make 
the output report difficult to read. 

Occurrence 
(from MAV) 

Optional - Gold* 

Assessment 
Sequence Number 

Optional - Gold* or specify a specific sequence number (refers to your MAB sequence 
number – see the Assessment set-up process manual) 

                                                           
3This section refers to step 3 on the Mark Entry process map in Appendix 3. 
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3. Run option 3 [Input actual marks for assessment for all student(s)] by clicking on the green arrow.   
 
Note: To enter marks for one specific student, complete the white box in option 3 with the student’s 
6-digit candidate number prior to running option 3.  
 
A student’s candidate number can be found in the SCN screen by entering the 9-digit student 
number (without the slash + instance). Ensure to select the candidate number for the correct 
academic year. 
 

 
 

4. A screen similar to this will appear (one window per assessment component): 
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 The sort order of the list, as well as whether the candidate number/student number and/or 
student name appears or not, is determined by the set-up of your College’s MAB record. See next 
section entitled List and sort order of students in SAS option 3. 

 To move between fields, use the Tab key.  

 To go from one student record to another, use the Page-up and Page-down keys. 

 If a student is not listed in option 3 that are you are expecting to see: 
1. Check that the student is attached to the module in SMO (if not, attach the student to 

the module as needed). 
2. Run option 1b on the missing student (input student number in blank field). 

 
5. In the Actual Mark and Grade fields, complete the students’ marks for the selected component 

(enter a mark out of 100%).  
 
Note: Ensure you are entering the correct component result for the correct component! 
 

6. Store (F6) frequently to avoid losing your work. 
 

7. When you are finished with one component and/or want to move to the next one, simply click on the 
X in the corner of the exam mark entry screen. This will bring up the next assessment component in a 
new window.  

 
 

8. As long as you have not calculated the overall module result (Option 6 in SAS), it is possible to change 
any of the marks entered, by re-accessing option 3. Locate the component/student in question and 
amend the mark/grade as needed. 
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Note: If you generate SMR records before the candidate number has been generated (in early 
September), any students without a candidate number will show their student number under student 
code instead of their candidate number.  This could have repercussions as students will not be listed 
correctly by candidate number, especially if the importing facilities (options 4 and 5) are used. 

 
 

List and sort order of students in SAS option 3 
 
You may change the way students are displayed in SAS option 3 as well as the order in which they are 
displayed. You must specify how to display the students for each individual component. 
 
1. Go to the MAB record for the module: 

1. Go to MAV. 
2. Double-click on the value in the Ass Pattern field for the year in question 
3. From the MAP screen, select Other > Assessment Body. 

 
2. You are now in the MAB. Highlight the component in question then select Other > More Details. The 

below screen will appear. 
 

 
 

3. Update the Print Name and Sort Options/Sort Criteria fields as needed and then store your changes 
(F6).  Possible combinations: 
 

Print Name field Sort Options/Sort Criteria (select one) field 

 
Yes  
 
(SPR code will also be displayed) 

 
- Candidate number (will not appear) 
- Name 
- Attempt  
 
Default sort order (if not specified)  = Name order 
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No 
 
(candidate number will appear) 

- Candidate number  
- Attempt (if this option is chosen, candidate numbers will be sub-
sorted in name order) 
 
Default sort order (if not specified) = Candidate # order 

 
You may also change the order of the Sort Criteria by selecting Ascent or Descent in the drop down 
list between the Sort Options and Sort Criteria. 
 

Alternatively, should the above options not be entirely suitable (i.e. will not sort the students in the 
desired order), you can sort the students within SAS option 3 by: 
 

1. selecting Misc > Sort within the mark entry screen:       
 

2. to then sort the students by: 

 Name — select SPR_CNAME from the dropdown list 

 Student code — select SPR_CODE.SAS from the dropdown list 

 candidate number — select Student candidate number (SAS_SCNC.SAS) from the dropdown 
list, 

 

   
 
 

CHECKING COMPONENT RESULTS (STEP 4)4 
 
After you enter the component results into SAS option 3, you should check that they’ve been entered 
correctly, before you calculate the overall module result. There are different ways to produce a list of 
components results. 
 
1- Report that you can run from the MAV screen that you can view in Excel: 

                                                           
4 This section refers to step 4 on the Mark Entry process map in Appendix 3. 
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List of component 
results 
 

 
List of the final module and/or individual assessment marks, in  
candidate number order, run from MAV: 
 

 EX-MODMARKSA — module results not calculated — displays  

component results 

 
2- Run option 11 in SAS to produce lists of marks that you’ve entered into SAS option 3: 
 

 Option 11 will display component marks prior to calculation (SAS option 6). 

 
The display and sort order of the above SAS reports can be altered as follows: MAV > double-click on value in Ass 
Pattern field > Say Yes > bring you to MAP > Go to Other > More Details > modify the Print Name fields and the Sort 
Options and Sort Criteria fields in the bottom of the screen. Details are in the Module Assessment and Reassessment 
Set Up notes on the SITS Course Notes website. 
 
 

CORRECTING COMPONENT MARKS/GRADES BEFORE THE MODULE RESULT IS CALCULATED (STEP 5)5 
 
If you spot a data entry error or a correction is needed to a component mark and/or grade before you 
have calculated the module marks, i.e. the student is still visible in SAS option 3 as SAS option 6 has not 
yet been run, you can alter component mark and/or grade as needed by: 
 

1. returning to option 3 in the SAS screen 
2. locating the student/component in question  
3. changing the mark/grade as needed 
4. storing your changes (F6) before exiting option 3. 

 

Quick tip!  If you only want to bring up one student’s record, enter the student’s 6-digit candidate 
number in the allocated field before running option 3: 
 

 
 
 

CALCULATING THE OVERALL MODULE MARK — SAS OPTION 6 (STEP 6) 6 
 
Based on the percentage split between the module assessment components (data which is kept in the 
MAB record – see the assessment set-up manual) and the mark schemes attached to the module, SITS will 
calculate the overall module result based on the component marks entered. 

 
All component marks for an individual student must be entered in order to calculate/set the module 
results. It is also possible to set marks for only some students (do not have to wait for all marks for all 
students to be entered to calculate results — the students whose records are incomplete will simply 
remain in SAS option 3). 

                                                           
5 This section refers to step 5 on the Mark Entry process map in Appendix 3. 
6 This section refers to step 6 on the Mark Entry process map in Appendix 3. 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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How to calculate the overall module result: 
 
1. Go to the SAS screen. 
2. Complete the following fields: 
 

Field name Value to be entered 

Year Academic year module taken in (e.g. 2015/6) 

Period Optional – enter period of module (TERM1, TERM 2, etc.) 

Level Optional – enter level of module (1 or 2, etc.) 

Module Enter a specific module code or use the wildcards to run the process for a 
group of modules (e.g. ARC1*) 
 
Note: do not run the process for all your College’s modules in one go as it 
will make the output report difficult to read 
 

Occurrence 
(from SMO) 

Optional - Gold* 
 

Assessment Sequence 
Number 

Optional - Gold* or specify a specific sequence number (refers to your MAB 
sequence number – see the Assessment set-up process manual). 

 
3. Run option 6, which will calculate the overall module result. 

 

Quick tip!  To only calculate a module result for one specific student, complete the white box in 
option 6 with the student’s candidate number before running option 6. 
 

 
 

4. If all is well, you will see the message “No text available in message frame” in the message line at the 
bottom of your screen. Otherwise a dialog box may appear indicating whose results were calculated 
and whose weren’t. Please consult the section on error messages at the end of these notes for any 
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other messages, which might appear. 
 

CHANGING COMPONENT AND MODULE MARKS/GRADES AFTER SAS OPTION 6 HAS RUN (STEP 7)7 
 
The process for changing the module and component marks and/or grades depends on: 

 whether there is a change to the component mark or a change in the overall module result mark 

 what stage the mark entry and calculation is at. 

 why the change is needed (data entry error or other reason) 

 
Before you have calculated the module marks (student still in SAS option 3) 
 
If you spot a data entry error or a correction is needed to a component mark and/or grade before you 
have calculated the module marks, i.e. the student is still visible in SAS option 3 as SAS option 6 has not 
yet been run, you can alter component mark and/or grade as needed by: 
 

1. returning to option 3 in the SAS screen 
2. locating the student/component in question  
3. changing the mark/grade as needed 
4. storing your changes (F6) before exiting option 3. 

 

Quick tip!  If you only want to bring up one student’s record, enter the student’s 6-digit candidate 
number in the allocated field before running option 3: 
 

 
 
 

After you have calculated the module result (SAS option 6 was run) 
 
There are 2 options: 
 

1. You must undo the current module result first, and then re-enter the correct mark. There are two 
ways of doing this: 

 

 MRM – Will delete all results records for individual or multiple student(s). You then need to 
start from scratch, and run option 1b on SAS to create a new SMR record, and then enter 
marks again. This option is the better one to use when you are new to the system, as it’s 
clearer to the user what they have done. See ‘How to delete an SMR record’ on page 16. 
 

 SMRU Undo option – This screen ‘rolls back’ to the previous state. The screen does not 
actually tell you exactly what it has done; you will need to check the SMR record to check it 
has done what you want. You need to have a good understanding of all the status code on 
SMR to use this screen. Advisable only to use it once you are very familiar with the SMR and 
SAS screens. 
 

2. You can modify the agreed component or module marks and/or grades — SMRU Modify option. 
 

Changing marks via the SMRU screen: 
 

                                                           
7 This section refers to step 7 on the Mark Entry process map in Appendix 3 
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1. Go to SMRU [SMR Undo]  
 

 
 

2. Complete the following fields:  (fields in italics are optional) 
 
Field name Value to be entered 

Module Module code 

Occurrence  Module occurrence (optional) 

Academic Year Academic year module was taken in, e.g. 2013/4 

Period Module period, e.g. TERM1 (optional) 

Candidate Key Student’s candidate number (optional) — otherwise will retrieve records for all 
students registered on the module 

 
3. Retrieve records (F5). 

 
4. See the following documents for instructions on how to modify or undo marks via the SMRU screen: 

Modifying and undoing calculated marks — SMRU screen. 
Using the SMRU screen to modify or undo calculated marks — process notes 
 
Both of the above documents are found on the SITS website > How do I? > How to and FAQs page 

 
In all of the above scenarios, if the change of mark and/or grade results in reassessment records needing 
to be created: 
 

1. Tab past the Minutes field to automatically create the Reassessment (SRA) records: 
 

http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitshowto/SMRU_process_maps_091213.pdf
http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitshowto/Using_the_SMRU_screen_to_modify_or_undo_calculated_marks_-_process_notes_251113.pdf
http://as.exeter.ac.uk/it/systems/sits/howdoi/howtoandfaqs/
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2. Press F6 to Store. 
 

3. If you see the below error message(s) just click Continue:  
 

4. If you do not want a reassessment (RAS) record to be created as a result of a failure in the 
module, contact the It Help Desk to have the RAS record deleted, thereby completing the module 
(set to Status COM in SMR). 

 
 

WITHDRAWN STUDENTS — HOW TO ENTER MARKS/DEAL WITH RESULTS RECORDS 
 
If a student withdraws from their studies, depending on date that the withdrawal is effective from (date 
will be indicated in the SPR notes field), the student’s modules can either be: 

 Marked as withdrawn (agreed grade of W applied), or 

 Deleted from the student’s record. 
 
SMR records for withdrawn students need to be completed and calculated, the same as those of active 
students. Their SMR records should not be left blank / in a SAS state. 
 
Until the student’s enrolment status has officially changed on the SPR screen: 

 Enter the results in SAS option 3 according to the result that the student received. 

 Allow SITS to generate a grade based on the mark scheme attached to the module. The grade 
allocated to the module can be amended at a later date via SAS option 3 or via the SMRU screen. 
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How to process based on the student’s current enrolment status: 
 
RLF (withdrawn — no active study this year): 
 
As the student has not had any period of active study this year, delete all module records for the current 
academic year — delete the SMR (via the MRM screen) and SMO records. 
 
RLE (withdrawn — active study this year): 
 
1. Check the following fields in SPR: 

 

 Start Date 

 Notes (looking for effective date of withdrawal) 

 

2. Is the student in their very first year of study8 of a UG or PGT programme? 

 

 Yes — go to step 3 

 No — skip to step 4. 

 

3. Is the student effective withdrawal/end date within the first 2 weeks of their start date? 

 

 Yes — Remove all module records for the current academic year — SMO and SMR (via the MRM 

screen). No further action required, do not continue to step 4. 

 No — go to step 4. 

 

4. What term does the effective withdrawal/end date fall under? 

 

 Within term 1 / by the end of term 1 / before the start of term 2: 9 

a. Delete all module records being taught in terms 2 and 3 (SMO and SMR records). 

b. TERM1 / TRM1+2 / TRM123 / TRM1+3 modules — update the records as per step 5. 

 

 Within term 2 /  by the end of term 2 / before the start of term 3: 2 

 Delete all term 3 module records (SMO and SMR records). 

 TERM2 / TRM1+2 / TRM123 / TRM2+3 modules — update the records as per step 5. 

 

 Within term 3 / by the end of term 3: 2 

a. TERM 3 / TRM123 / TRM2+3 modules — update the records as per step 5. 

 

                                                           
8 Search for all of the students’ records in SPR — if the student is currently an undergraduate and left a UG 
programme last year, this record is NOT considered their first official year of study. Same logic for PGT student. 
 
9 Consider when the final assessment for the module is being taken before marking the module as withdrawn. For 
example, if the student’s effective date is on the final day of term 1, mark the module as interrupted if the final 
exam isn’t taking place until January, but don’t mark is as withdrawn if the student submitted the final coursework 
assessment before withdrawing. 
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5. Update the affected modules as follows: 

 

 SMO screen — update C/O field to W, for withdrawn. 

 

 

 SMR records — enter the mark that the student achieved on the component (e.g. enter 0 if they 
didn’t submit or enter the mark allocated) and ensure that the agreed module grade = W: 
 

i. apply grade of W to all components in SAS option 3 (delete the auto-generated grade and 
replace by W) and calculate module via SAS option 610  
 
or  
 

ii. update agreed grade to W via SMRU screen if the module result has already been 
calculated. 
 

Quick tip!  The grades across all of the components for the module will need to match (i.e. all 
be set to W), otherwise it may cause issues when you calculate the final module result via SAS 
option 6. This means you may have to modify the grade (to W) on components that were 
previously entered. 

 
 
 
 
 

Eligibility for lesser awards 
 
Students who have withdrawn (whether voluntary or enforced) may have completed sufficient credits to 
receive a lesser award, and colleges should be issuing these awards as standard practice. Below are some of 
the more commonly used lesser awards: 
 

Award Total Credit Value for 
Award 

Faculty Classified? Generated by PSA 18 

Certificate of Higher 
Education 

120 UG No No 

Diploma of Higher Education 240 UG No No 

Postgraduate Certificate 60 PGT Yes Yes 

Postgraduate Diploma 120 PGT Yes Yes 

 
A full list of eligible lesser awards for both UG and PGT students can be found in section 9 – Academic Credit 
Requirements for Award of the Credit and Qualifications Framework, with further details on classification rules 

                                                           
10 Where the students’ results are in the RAS screen, do the above but enter into RAS option 2 and calculate in RAS 
option 5a. 

http://as.exeter.ac.uk/academic-policy-standards/tqa-manual/cqf/academiccredit/#table-two
http://as.exeter.ac.uk/academic-policy-standards/tqa-manual/cqf/academiccredit/#table-two
http://as.exeter.ac.uk/academic-policy-standards/tqa-manual/cqf/academiccredit/
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(where relevant) in section 9 – Classification of Awards of the Assessment, Progression and Awarding: Taught 
Programmes Handbook.  
 
Certificates and Diplomas of Higher Education for undergraduate students are not automatically generated by 
running PSA option 18 in SITS (PG Cert/PG Dip awards are calculated by PSA option 18), and therefore need to 
be created manually. Full guidance on manually creating a lesser award can be found in the Awarding a student 
a Certificate or Diploma of Higher Education notes. Once the award has been created the normal awarding 
process can be followed.  

 
 

Print list of withdrawn students (optional) 
 
To print a list of modules that your College’s withdrawn students are registered for: 
 
1. Go to SCE 
2. Complete the following fields and retrieve: 
 

Field name Value to be entered 

Acad Year Current academic year, e.g. 2014/5 

Enrolment status RLE ·|RLF 

Programme (near bottom of screen) Specific programme code 

 
3. From the All menu, choose Gen + Print Letters 
4. In the Standard Letter Selection window, complete the letter code field with EX-WITHINT and hit the 

Tab key. 
5. Print a list of students have withdrawn, the modules they were enrolled on and their candidate 

numbers, for each of their years of study on that programme. 
 
 

INTERRUPTED STUDENTS — HOW TO ENTER MARKS/DEAL WITH RESULTS RECORDS 
 
If a student interrupts their studies, depending on dates that the interruption will take place (dates will be 
indicated in the SPR Notes field), the student’s modules can either be: 

 Completed as usual 

 Deleted from the student’s record 

 Marked as interrupted (agreed grade of I applied) and superseded. Not all module records need 
to be identified as ‘interrupted’. It all depends on when the student interrupted. For example, if a 
student completed term 1 and interrupted during the course of term 2: 

 

 The term 2 modules must remain on the student’s record and will need to be identified as 
interrupted (as the student did not complete them).  

 

 The term 1 modules can remain as originally entered (i.e. without any interruption flags 
on them) as the module results can be retained for future awarding. If the student 
completed term 1, it is likely that they will return for the start of term 2 in the following 
academic year. 

 
SMR records for interrupted students need to be completed and calculated, the same as those of active 
students. Their SMR records should not be left blank / in a SAS state. 
 
Until the student’s enrolment status has officially changed on the SPR screen: 

 Enter the results in SAS option 3 according to the result that the student received. 

http://as.exeter.ac.uk/academic-policy-standards/tqa-manual/aph/classification/
http://as.exeter.ac.uk/academic-policy-standards/tqa-manual/aph/classification/
http://as.exeter.ac.uk/academic-policy-standards/tqa-manual/aph/classification/
https://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitsfaq/Awarding_a_student_a_Certificate_or_Diploma_of_Higher_Education.pdf
https://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitsfaq/Awarding_a_student_a_Certificate_or_Diploma_of_Higher_Education.pdf
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 Allow SITS to generate a grade based on the mark scheme attached to the module. The grade 
allocated to the module can be amended at a later date via SAS option 3 or via the SMRU screen. 
 

 
How to process based on the student’s current enrolment status: 
 
RHL_I (interruption) or RHL_M (medical interruption): 
 
1. Check the following fields in SPR: 

 Start Date 

 Notes (looking for start date of interruption) 

 

2. Is the interruption start date before the start of term or on the first day of term? 

 

 Yes — As the student has not had any period of activity, remove all module records for the 

current academic year covering the period of interruption11 in SMO and SMR (via the MRM 

screen). No further action required, do not continue to step 3. 

 

 No (after start of term) — go to step 3. 

 

 Is the student in their very first year of study12 of a UG or PGT programme? 

 Yes — go to step 4. 

 No — skip to step 5. 

 

3. Is the student interruption start date within the first 2 weeks of their programme start date? 

 

 Yes — Remove all module records for the current academic year covering the period of 

interruption11 in SMO and SMR (via the MRM screen). No further action required, do not continue 

to step 5. 

 

 No — go to step 5. 

 

4. Which term does the interruption start date fall within? 

 

 Within term 1 / by the end of term 1 / before the start of term 2: 13 

a. Delete all module records being taught in terms 2 and 3 (SMO and SMR records). 

b. TERM1 / TRM1+2 / TRM123 / TRM1+3 modules — update the records as per step 6 – 8. 

                                                           
11 If the student is returning within the academic year, don’t delete modules within the terms that they will be back 
for. For example, if the student is returning in term 2, don’t remove the term 2 modules. 
 
12 Search for all of the students’ records in SPR — if the student is currently an undergraduate and left a UG 
programme last year, this record is NOT considered their first official year of study. The same logic applies to PGT 
students. 
 
13 Consider when the final assessment for the module is being taken before marking the module as interrupted. For 
example, if the student’s interruption start date is on the final day of term 1, mark the module as interrupted if the 
final exam isn’t taking place until January, but don’t mark it as interrupted if the student submitted the final 
coursework assessment prior to interrupting. 
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 Within term 2 /  by the end of term 2 / before the start of term 3: 13 

a. Delete all term 3 module records (SMO and SMR records). 

b. TERM2 / TRM1+2 / TRM123 / TRM2+3 modules — update the records as per steps 6 - 8. 

 

 Within term 3 / by the end of term 3: 13 

a. TERM 3 / TRM123 / TRM2+3 modules — update the records as per steps 6 - 8.   
 

5. SMO — update C/O field to I. 

 

 
 

6. SMR records — enter the mark that the student achieved on the component (e.g. enter 0 if they 

didn’t submit or enter the mark allocated) and ensure that the agreed module grade = I: 

 apply grade of I to all components in SAS option 3 (delete the auto-generated grade and 
replace by I) and calculate module via SAS option 614  
 
or  
 

 update agreed grade to I via SMRU screen if the module result has already been calculated. 
 

Quick tip!  The grades across all of the components for the module will need to match (i.e. all be set to 
I), otherwise it may cause issues when you calculate the final module result via SAS option 6. This means 
you may have to modify the grade (to I) on components that were previously entered. 

 
7. SMRS records — set Selection field to S (supersede modules so SITS ignores them in award 

calculations and identifies modules as such on transcripts/HEAR). 

                                                           
14 Where the students’ results are in the RAS screen, do the above but enter into RAS option 2 and calculate in RAS 
option 5a. 
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Print list of interrupted students (optional) 
 
To print a list of modules that your College’s interrupted students are registered for: 
 
1. Go to SCE 
2. Complete the following fields and retrieve: 
 

Field name Value to be entered 

Acad Year Current academic year, e.g. 2014/5 

Mode of Attendance INT ·* 

Programme (near bottom of screen) Specific programme code 

 
3 From the All menu, choose Gen + Print Letters. 
4 In the Standard Letter Selection window, complete the letter code field with EX-WITHINT and hit the 

Tab key. 
5 Print a list of students have interrupted, the modules they were enrolled on and their candidate 

numbers, for each of their years of study on that programme. 
 

EXPORTING MARK SHEETS AND IMPORTING MARKS INTO SITS 
 
Instead of manually entering marks into SAS option 3, you may export a spreadsheet that academics can 
complete and then return to you, allowing you to import the results into SITS. 
 
Note: It is important that the format of the exported file is not amended otherwise the import will fail. 
 
You must first export the mark sheet and then import the marks (once they’ve been inputted into the 
exported mark sheet). 
 
 

How to export a mark sheet and import new marks: 
 
1. Go to the SAS screen > enter the academic year and module code.  

 

If the module has multiple occurrences (Occ field in MAV) and you only want to export a mark sheet 

for one occurrence, complete the Occurrence field. 

 



  

Mark Entry v.9.4.2.0 — last updated September 2019 (JP)                                                                                                            30 

If you wish to restrict the export to one assessment, enter the MAB sequence number for that 

assessment in the Assessment sequence number field. 

 

 
 

2. Ensure the gaps to enter marks are present in SAS option 3, i.e. SMR records have been created by 

running SAS > option 1b. For instructions on how to do this, see Create SMR records — option 1b. 

 

3. Go to Option 4 (Export actual marks…) and then: 

a) click on the folder icon  

b) specify the save location (e.g. Desktop, My Documents) 

c) name the file (File Name field) and delete the *.* extension in the file name, replacing it 

by a .csv extension. 

 

 
 

d) click the Save button 

4. When returned to the SAS screen, click on Run (green arrow) on the end of option 4. 
 

 
 
The message line at the bottom of the screen will display the export’s progress and, once completed, 
will indicate where the export file has been created and how many records were generated. 
 
In the example below, 186 records were created as there are 93 students on the module and 2 
assessment components in MAB — 93 x 2 = 186). If component marks have already been input 
against some records, these will be included in the count. 
 

 
 

5. Open the exported file via Excel. It will look like this: 
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 Column D (Occ) — the occurrence of the module, as per MAV. 

 Column F (#Ass#) — the assessment sequence number attached to the component in 

MAB. 

 Column H (Name) — student’s name. 

 Column J (Mark) — enter a whole number out of 100. 

 Column K (Grade) — no need to populate (unless you need to input a grade that you 

would normally manually enter (e.g. MI, W, I) as SITS will populate the grade according to 

the component mark scheme attached to the module. 

 Column N (Component Name) — component title as per MAB, attached to the sequence 

number. 

 Column O (SPR Number)  

 Column P (Candidate Number SAS) and Column Q (Candidate Number RAS) — student’s 

candidate number (SCN) for the given academic year based on the current SAS/RAS 

records. 

 

Important note! 

 Do not delete/amend any columns or pre-populated data from the file (otherwise it will not 

import properly)! See next section entitled Adding new columns to the exported mark sheet 

for instructions as needed or see instructions in step 6. 

 

 If you do make any changes (following the guidance below), ensure that you re-save it as a csv 

file. 

6. If entering marks on behalf of academics: 
 

 You can enter marks directly into the marks column (J).  

 Ensure you are entering them for the correct assessment and that you enter whole numbers only, 
out of 100%.  

 Ensure to save your changes in .csv format. 
 
7. If you are sending the file to an academic (for them to input their marks directly into the Mark 

column): 

 You may want to sort the data by assessment number (i.e. MAB sequence number), then by 
student number, then hide column H containing the student name.  

 You may also want to lock the spreadsheet (this is optional) so that they can only add values to 
the Mark column.  
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To lock the spreadsheet so that only marks can be entered (and date in other columns cannot be 
amended), do the following: 
 

a) Highlight the Mark column (J). 
 

b) Click the Expand button at the bottom right of the Font section of the Home tab, and then click 
Protection tab: 
 

 
 

c) Ensure the Locked check box is unticked and click OK: 
 

 
 

d) Go to the Review tab and select Protect Sheet (to lock the file you must protect the sheet): 
 

 
 
Click OK to only activate protection.  
 
Should you wish to password protect the protection feature (i.e. so the worksheet cannot be 
‘unprotected’ without entering a password), enter a password to protect the sheet before clicking 
OK. Ensure it’s a password that the entire admin team knows! 
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e) Save the file as an Excel workbook (.xslx) because csv files do not “remember” the locking and 
password protection. 

 
Your spreadsheet is now ready for academics to enter marks in column J (Mark). They must enter 
those marks as integers (i.e. whole numbers) only, out of 100%. 

 
8. If you sent the spreadsheet to an academic, you will need to do the following before importing it into 

SITS (depending on the actions taken before you sent it to the academic): 
 

a. Unprotect the sheet (Review tab > click on Unprotect Sheet icon). 
 

b. Unlock the file (Home tab > Font section > click on Expand button in bottom right > Protection tab 
> ensure Locked is unticked > click OK).  
 

c. Unhide the Name column (column H). 
 

d. Convert it back to a .csv file. 
 

9. The file is now ready to re-import into SITS. 
 
 

Importing the mark sheet in to SITS 
 

1. Go to the SAS screen > in Option 5 (Import actual marks) > hit the folder icon , find your exported 
file that now contains marks and run the process (click on the green arrow). 
 

 
 

2. After the file has been imported it is important to check the message line (bottom of the screen) to 
see if there were any errors with importing the file.  
 

a. Marks were imported successfully: 
 

 
(no errors mentioned — in the above example, 6 individual marks were listed in the 
spreadsheet so 6 marks were imported). 
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b. Some records imported but not all of them (the most common reason for records not to be 
imported is that they already exist in the database): 

 

 
 

c. One or more errors with importing the file and no file was imported: 
 

 
 

 
Please note that: 
 
The import will not overwrite any marks that have: 

 been manually entered into SITS 

 have been imported on a previous occasion (so all corrections need to be made in SAS 
option 3) 

 
Marks that already exist in SITS will be returned as an error; so in fact you might be showing 
errors on your import where there are no errors. 

 
3. Marks should now be in SAS option 3. Check for any gaps. 

 

Grades will have been automatically allocated based on the component mark scheme attached to the 

component. You may have to alter the Grade in certain cases, for example: 

 

a. interrupted student — the grade of P/FC/FR/F that SITS automatically allocated based on the 

component mark scheme will have to be manually altered to I. 

b. withdrawn student — the grade of P/FC/FR/F that SITS automatically allocated based on the 

component mark scheme will have to be manually altered to W. 

c. student who had mitigation application/deferral approved — the grade of P/FC/FR/F that SITS 

automatically allocated based on the component mark scheme will have to be manually 

altered to MI. 

 

4. Once all of the component marks have been correctly input/imported, calculate the module via SAS 

option 6. 

 

Adding new columns to the exported mark sheet 
 
If you want to add additional columns to the mark sheet (option 4 export), consider this. 
 
If the columns/fields that you wish to add do not exist in SITS (e.g. a column for a 2nd marker’s result): 
 
If the new columns are inserted (post-export)…: 
 

 After the existing columns (so added from column R) and the data is left in (columns not removed 
before importing into SITS) — the import will work. 
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 Next to the Mark column and left in for the import — the import will not work (as you can't alter 
existing columns/alter their order) 
 

 Next to the Mark column but removed before the import — the import will work. 
 

If the columns/fields that you wish to add exist in SITS: 
 
You may add fields that exist in the following screens: STU, SPR, MAV and MAB.   
 
Get in touch with your SITS contact via sr-admin@exeter.ac.uk to discuss. 
 
 

EXPORT MARKS FROM ELE GRADEBOOK AND CREATE A MARK IMPORT FILE FOR SITS 
 

 More academic colleagues are moving to marking electronically using Turnitin Grademark functionality 
provided through ELE or marking assignments (e.g. quizzes or examinations) directly in ELE. Unfortunately 
there is no way currently to take marks directly from ELE/Turnitin Grademark and import directly to SITS. 
 
To facilitate the import of ELE/Turnitin marks to SITS we can use the ELE Gradebook to SITS Format 
Converter, developed by Paul Thornton in Exeter IT, which allows the insertion of the mark from ELE into 
the SITS mark import template if you follow the steps below. 
 
It is good practice to ensure that the module code and the academic year are included in the name of the 
assessment on ELE, and that the name of the assessment matches what is in SITS (which in turn should be 
a faithful copy of what’s on the module descriptor). This will allow you to easily identify an assessment in 
ELE and the corresponding assessment in SITS. 
 
To import ELE marks to SITS you need to first of all extract the marks from ELE. To do so follow these 
steps: 
 
1. Navigate to the relevant module in ELE. 

 

 
 
2. Click on the module to access the module content and the administration suite, then click on Grades 

in Administration. 

mailto:sr-admin@exeter.ac.uk
https://utils.exeter.ac.uk/acadsys/elesitsconvert/index
https://utils.exeter.ac.uk/acadsys/elesitsconvert/index
http://vle.exeter.ac.uk/
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3. Clicking on Grades takes you to the Grade administration section, from which you can export a file 
containing students’ marks for a given assessment by clicking on the Export tab. The file must be 
created in plain text format, and you can select as many assessments to export as you like. Until you 
are comfortable with the export, it is recommended that you select only one assessment at a time, by 
clicking Select all/none and then ticking the relevant assessment. In the Export format options, ensure 
that the Separator is set to Tab, then click Download. 
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4. On clicking Download a dialogue box will appear asking whether you want to open or save the file. 
Save the file. The file will be saved according to your browser settings (for example, my files are saved 
to my Downloads folder). I suggest that you create a folder on a relevant drive and move all such ELE 
exports to that folder (for example, I have a folder on the CLES Education N Drive that I use for this 
purpose); that way you are storing all the exports in one place. 

 

5. Once you have created the ELE export file, you need to convert it using the ELE Gradebook to SITS 
Format Convertor. 

 

https://utils.exeter.ac.uk/acadsys/elesitsconvert/index
https://utils.exeter.ac.uk/acadsys/elesitsconvert/index
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6. Click Browse to locate and select the ELE file that you have just exported from ELE, then click on 
Process File. This process generates a link to a csv file (or files if you ticked more than one assessment 
in Step 3).  

 

 
 

7. Click on the link to the csv file and you will again be asked whether you want to open or save the csv 
file. Choose save and then move the file to the same location as the original ELE export. (It is good 
practice to include the module code in the name of the assessment when setting up the assessment 
in ELE because the code will then be included in the filename of the csv export file; this is particularly 
important in the case of ELE courses that are linked to multiple modules.) 

 
8. Open the file, and you will see a number of columns identifying the student, including the assessment 

mark (Grade column) and the SPR code; the SPR code column will very occasionally contain multiple 
values where a student has multiple active records (multiple records will be bar-separated (i.e. 
separated by the | character)). Simply delete the incorrect SPR code. 

 

9. The process for uploading marks into SITS via a marks template is described in the ‘Importing mark 
sheet in to SITS’ section above. You must ensure that you have exported the mark sheet from SITS 
(described in section 1) for the correct assessment records so that they match the assessment against 
which marks are recorded in ELE.  

 
We need to adapt the process slightly to transfer the mark from the ELE export file into the SITS import 
file; to do this we need to create a primary key in the ELE export that matches the primary key in the SITS 
import. The primary key in the SITS import is the candidate key preceded by #, for example #64xxxxxx/1. 
 
10. In the ELE export file add a blank column in front of the Grade column and name that column SITS 

primary key. In cell G2 use the CONCATENATE syntax. This essentially creates a value that is the SPR 
code preceded by #. Copy the formula down to the final record. This process of using CONCATENATE 
and VLOOKUP syntaxes to create a SITS import file can also be used for assessments that are marked 
using Question Mark Perception (QMP). 
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11. Then in the SITS import file create a VLOOKUP statement that links to the new primary key in the ELE 
export file.  

 

 
 
12. Essentially the VLOOKUP statement searches for the #SPR_CODE value in the ELE import file and, if it 

finds a match, copies the value from column 2 (the Grade column) into the SITS import file. Copy the 
formula down to the final record but ensure that you do not overwrite any extant values (for 
example, 0 indicating withdrawn or interrupted or actual marks that may have already been 
processed). You can do this by applying a filter and showing only blanks or by copying and pasting the 
contents of the cell to all blank cells in the Mark column. 

 
13. You need to check values that are equal to 0 – is that genuinely a mark of 0 from ELE or is that an 

Excel error because the mark is blank against the student in the ELE export file (perhaps because of an 
outstanding plagiarism query)? If the mark is genuinely 0, leave it in place. If it’s not 0, delete from the 
SITS import file so you don’t inadvertently import it into SITS.  

 

14. You need to check where the mark returned equals #N/A – this is an Excel error that most likely 
indicates that the student in the SITS import file does not exist in the ELE export file. Delete the value 
of #N/A and then investigate why the student is not in the ELE export (for example, the student may 
simply not have submitted the assessment). 

 
15. Once you are satisfied that the marks are correct, you can import the file to SITS as described in the 

Import  
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16. Import to SITS in this way removes significant potential for human error that occurs during manual 
processing of marks, but does not remove the need to check that you are recording the correct marks 
against students’ records.  

 

 

DELETING STUDENT MODULE RESULT (SMR) RECORDS — MRM SCREEN 
 
You may need to delete SMR records for a number of reasons (e.g. the student decides to change 
modules after SMR records generated, need to move student to another module occurrence, etc.). 
 

Important reminders: 
 DO NOT delete SMR records from the SMR screen. This will leave records hanging in SITS. 

 Always delete a SMR record (via the steps below), BEFORE deleting the SMO record. 
 

How to delete an SMR record for a student: 
 
1. Go to the MRM screen. 

 
2. It is very important that you complete the following fields to retrieve the desired record only: 

 
Field name Value to be entered 

Student Complete with the student’s SPR number 

Year Academic year (e.g. 2012/3) 

Period Optional — period module is running in (TERM1, TRM1+2, etc.). 

Module Module code 

Occ (from SMO) Optional — module occurrence (usually A) 

 

 
 

3. Retrieve (F5).  
 

4. Check that the correct record(s) have been retrieved (e.g. correct module, year, student (student’s 
name appears in bottom of screen).  
 
Warnings: 

a. This is important as you cannot undo this process — the records will be permanently deleted.  
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b. If you retrieve multiple records and run the process, all records on screen will be deleted, i.e. 
running it on the below will delete all records, not only LAWM008: 
 

 
 

5. Click on the green arrow on line 1 — Delete all SMR. You will be asked whether you are sure, allowing 
you to back out of the process at this particular point.  
  

 
 

6. By clicking ‘Yes’ you will then be asked whether you want to print the details, print if you want to 
keep a record of it.  
 

7. The SMR and the underlying records have now been permanently deleted. 
 

8. If the student is also to be removed from that module, you will also need to delete the SMO record.  
 
This can be done by using File > Delete in SMO when the appropriate student record/module is 
selected. 

 
Note: Don’t forget to advise Exams Office of any changes near the exam timetable creation time. 
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CHANGE IN MODULE ASSESSMENT SET-UP AFTER SMR RECORDS GENERATED AND/OR MARKS HAVE 

BEEN ENTERED  
 
Sometimes, once the SMR records have been generated: 

 academics decide to change the module assessment set-up after you have started entering marks 
(any changes to the way in which a module is assessed should be approved by the Accreditation 
Committee) 

 there was an error in the module set-up 

 a student was on an incorrect MAV occurrence or assessment group.  
 

Unfortunately there is no quick and easy way of dealing with these changes. You cannot simply amend 
the MAV/MAB records as the changes will not carry over to the SMR records. 
 
Steps to follow: 
 

1. Remove/delete the existing SMR records for that module (see page 33 — Deleting Student 
Module Result records). 
 

2. Amend the MAB records for the module (refer to Module Assessment & Reassessment Set-up 
notes to correctly update methods of assessments) 
 

3. Regenerate the SMR records (SAS option 1b — see page 10 for instructions) 
 

4. Re-enter the marks via SAS option 3 (see page 13 for instructions). 
 

STUDENT CANDIDATE NUMBER (SCN) — HOW TO LOCATE 
 
A student receives a new candidate number each academic year. To find a student’s candidate number 
 
1. Go to SCN [Student Candidate Number] 
2. Complete one or more of the following fields: 

 
Field name Value to be entered 

Student Student’s 9 character long student number (without the /1 or /2, etc.)  

Name Student’s surname followed by Gold* 

Year Desired academic year (e.g. 2013/4) 

 
3. Retrieve (F5). This will give you the student’s candidate number. 
 
Note: You can also find a student number by searching on a 6-digit candidate number. 
 

REPORTS  
 

Component and module results 
 
Reports that you can run from the MAV screen: 
 

 
List of Marks 
 

 
List of the final module and/or individual assessment marks, in  
candidate number order, run from MAV: 

http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitscoursenotes/Module_assessment_reassessment_setup.pdf
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 EX-MODMARKSA (module results not calculated — displays  

component results)  

 EX-MODMARKS (module results calculated — displays  

component and module results) 

 
You can also run options 11 or 12 in SAS to produce lists of marks that you’ve entered into SAS option 3: 
 

 Option 11 will display component marks prior to calculation (SAS option 6). 

 Option 12 displays calculated results with component results.  

 
The display and sort order of the above SAS reports can be altered as follows: MAV > double –click on value in Ass 
Pattern field > Say Yes > bring you to MAP > Go to Other > More Details > modify the Print Name fields and the Sort 
Options and Sort Criteria fields in the bottom of the screen. Details are in the Module Assessment and Reassessment 
Set Up notes on the SITS Course Notes website. 
 
 

Module statistics 
 
These reports are run via MAV once the marks for the entire module have been set in SITS: 
 

 PG — EX-MODSTATPG (need to open via Excel) 

 

 UG — EX-MODSTATP (prints directly from SITS) or  

EX-MODSTATEP (opens via Excel) 

 
 

Student Candidate Number (print list of candidate numbers by programme) 
 
Run report EX-CANDLST from SPR. See http://as.exeter.ac.uk/it/systems/sits/howdoi/reports/ for an 
example of the report’s output. 

 
Interim transcripts 
 
See the reports & how to pages on the SITS website for full instructions & examples — 
http://as.exeter.ac.uk/it/systems/sits/howdoi/moduleresultson-line/  
 
 

PRINTING/PRODUCING MARK SHEETS 
 
Blank mark sheets, for your academics to complete, can be produced in several ways. These are: 
 
1. Excel (recommended option) – there is a standard letter in the system, which will create a mark sheet 

in Excel format (one sheet per module, with components listed horizontally).  
 

o The report is run from MAV and the letter code is EX-MARKSHEET. The output looks like this: 
 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
http://as.exeter.ac.uk/it/systems/sits/howdoi/reports/
http://as.exeter.ac.uk/it/systems/sits/howdoi/moduleresultson-line/
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2. Report – Running option 2a on the SAS screen will produce a mark sheet that prints out of the system 
directly (one sheet per module component).  

o You must have created the SMR records first (SAS option 1b)  
o You must specify the assessment sequence number you are producing the mark sheet for 

(assessment sequence number can be found in MAB). 
 

 
 
The output looks like this: 
 

 
 

3. Write your own Standard Letter to create a unique mark sheet for your College (you will need to 
attend a reporting training session to be able to create your own reports). 
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HESA REQUIREMENTS 
 
In order to comply with the HEFCE 13 month rule we need to capture vital information about whether a 
student has completed the ‘Final Assessment’ (FA).  This change will have an impact on the way Colleges 
process some of their module data, which is outlined below.  In brief Colleges will now be asked to 
identify the ‘Final Assessment’ for each module in the MAB screen and to complete SMR UDF 3 and 4 
where appropriate.  More detailed description of this change is outlined below.  Student Records/Exeter 
IT will be responsible for completing SMR UDF 1 and 2. 
 
In preparation for this change Colleges should have hopefully already gone through their Assessment 
Patterns and for each module indicate on the Module Assessment Body (MAB) Screen what is considered 
the ‘Final Assessment’.  In terms of HESA this is generally considered to be the last assessment taken by 
the student chronologically: 
 

 
 
In SMR we have set up 3 UDF fields to assist with the task of correctly assigning the right module outcome 
for each module a student has taken (i.e. whether the student successfully completed the module or not): 
 

 
 
 
Field Name Name Description/Populated by 

UDF 1 Final Submission Date The final date for which a student can attempt the ‘Final 
Assessment’.  This date is 13 months after they have commenced 
their study for a particular academic year.   
 
The initial date for when a student commenced their study is worked 
out by using the HESA COMDATE in SCJ and then for every 
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subsequent year a student is here this will be incremented by a year.  
The final submission date will be populated in this field against every 
SMR record a student has taken in the current HESA academic year 
by a nightly script. 

UDF 2 Submitted Date For modules where is it possible that a mark will not have been 
entered into SITS by the 13 month date (i.e. postgraduate 
dissertations) we will use the fact that the student has submitted the 
‘Final Assessment’ as evidence that they have completed the 
module.  This information will be extracted from BART and imported 
into this field.   
 
It is expected that using this method this will be the exception rather 
than the rule and Academic Systems must be informed if there are 
any modules apart from postgraduate dissertations that need to be 
included in the BART extract. 
 

UDF 3 Attempted FA at 1st 
Attempt? 

Where a student has gained a mark of 0 for the ‘Final Assessment’ at 
the first attempt (i.e. the module is at SAS status) but the student 
has actually attempted the assessment Colleges should populate this 
field with a 1.  This is so we know the student has completed the 
module as defined by HEFCE. 
 
Where the ‘Final Assessment’ is a straight Pass/Fail assessment if a 
student has an F at the first attempt but the student has actually 
attempted the assessment Colleges should populate this field with a 
1.  This is so we know the student has completed the module as 
defined by HEFCE. 
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APPENDIX 1 — MARK SCHEMES  
 

General UG component mark scheme: UCOM01 (automatic condonement) and UCOM02 (automatic referral) 
*   UCOM01 default  ** UCOM02 default 
 
Initial assessment 
This table outlines which grade SITS will automatically assign to a component mark when entered in SAS option 3, based on the component mark scheme 
assigned to each individual component in the MAB screen.  
 

Mark 
entered in 
SAS option 
3 

Default grade 
assigned by 
SITS  

Meaning Details 

40-100 P Pass   

0-39 * FC Fail (condoned)   

0-39 ** FR Fail (refer)  If module is failed overall, student offered 2nd attempt at module, based on reassessment pattern set up, for 
capped module mark of 40%.  

 
Reassessment  
This table outlines which grade SITS will automatically assign to a component mark when entered in RAS option 2, based on the component mark scheme 
assigned to the assessment pattern in the MAP screen > Re-ass MKSCH field.  
 

Mark 
entered in 
RAS 
option 2 

Default grade 
assigned by 
SITS  

Meaning Details 

40-100 P Pass   

0-39 * FC Fail (condoned)   

0-39 ** FR Fail (refer)  If this was the student’s deferred attempt (chance to sit assessment again for uncapped mark) — grade of FR will 
be applied to component as student allowed 2nd attempt at module if failed overall. 

0-39 ** F Fail — Credits not 
awarded to student 

If this was the student’s referred (2nd) attempt (chance to resit assessment for capped mark) — grade of F will be 
applied to the component (no condonement, no reassessment). 

 
For a list of grades that can be manually applied to component/module results, Appendix 2. 
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General UG module mark scheme: UMOD01 (automatic condonement) and UMOD02 (automatic referral) 
 
*   UMOD01 default   
** UMOD02 default 
 
Initial assessment 
 
This table outlines which grade SITS will automatically assign to a module mark when the result is calculated in SAS option 6, based on a combination of the 
component mark schemes assigned in MAB as well as the module mark scheme assigned to the module in the MAV screen.  
 

Module result 
as calculated by 
SAS option 6 

Grade Meaning Details Notes 

70-100 1 First Class Pass  
 
Module completed and student 
awarded credits 
 

 

60-69 21 Second Class Div I Pass  

50-59 22 Second Class Div II Pass  

40-50 3 Third Class Pass  

0-39 FC * Fail (condoned) A maximum of 30 credits per year can be condoned if the student’s overall 
credit-weighted average is 40+. 
 
If the component mark scheme is set to UCOM02 on all components on 
MAB, this will override UMOD01 and module result will be treated as 
UMOD02.  

0-39 FR ** Fail (Refer) Result is treated as a fail and 
will go into reassessment 

If this was the student’s deferred attempt (chance to sit assessment again 
for uncapped mark) — grade of FR will be applied to component as student 
allowed 2nd attempt at module if failed overall. 

 
Reassessment 
 
This table outlines which grade SITS will automatically assign to a module result when calculated in RAS option 5a, based on the component mark scheme 
assigned to the assessment pattern in the MAP screen > Re-ass MKSCH field.  
 
*   UCOM01 default  ** UCOM02 default 
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Module result as 
calculated by RAS 
option 5a 

Default grade 
assigned by 
SITS  

Meaning Details Notes 

40-100 P Pass  Module completed and 
student awarded credits 
 

 

0-39 * FC Fail (condoned)  Module completed and 
student awarded credits 
 

A maximum of 30 credits per year can be condoned if the student’s overall 
credit-weighted average is 40+. 
 

0-39 ** FR Fail (refer)  Module completed and 
student is not awarded 
credits 
 

If this was the student’s deferred attempt (chance to sit assessment again for 
uncapped mark) — grade of FR will be applied to component as student 
allowed 2nd attempt at module if failed overall. 
Reassessment record will need to be created in next academic year. 

0-39 ** F Fail — Credits not 
awarded to student 

Module completed and 
student is not awarded 
credits 

If this was the student’s referred (2nd) attempt (chance to resit assessment for 
capped mark) — grade of F will be applied to the component (no 
condonement, no reassessment). 

 
For a list of grades that can be manually applied to component/module results, Appendix 2. 
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NEW PGT MARK SCHEMES – COMPONENT MARK SCHEMES 
 

PCOM01 (automatic condonement) and PCOM02 (automatic referral) 
*   PCOM01 default  ** PCOM02 default 
 
Initial assessment 
This table outlines which grade SITS will automatically assign to a component mark when entered in SAS option 3, based on the component mark scheme 
assigned to each individual component in the MAB screen.  
 

Mark entered in 
SAS option 3 

Default grade 
assigned by SITS  

Meaning Details 

50-100 P Pass   

0-49 FC * Fail (condoned)   

0-49  FR ** Fail (refer)  If module is failed overall, student offered 2nd attempt at module, based on reassessment 
pattern set up, for capped module mark of 50%.  

 
For a list of grades that can be manually applied to component results, see the Mark Entry notes on the SITS > Course Notes site. 
 
Reassessment  
This table outlines which grade SITS will automatically assign to a component mark when entered in RAS option 2, based on the component mark scheme 
assigned to the assessment pattern in the MAP screen > Re-ass MKSCH field.  
 

Mark entered 
in RAS option 
2 

Default grade 
assigned by 
SITS  

Meaning Details 

50-100 P Pass   

0-49  FC * Fail (condoned)   

0-49  FR ** Fail (refer)  If this was the student’s deferred attempt (chance to sit assessment again for uncapped 
mark) — grade of FR will be applied to component as student allowed 2nd attempt at module 
if failed overall. 

0-49  F ** Fail — Credits not awarded 
to student 

If this was the student’s referred (2nd) attempt (chance to resit assessment for capped mark) 
— grade of F will be applied to the component (no condonement, no reassessment). 

 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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For a list of grades that can be manually applied to component results, see the Mark Entry notes on the SITS > Course Notes site. 
 
 

NEW PGT MARK SCHEMES – MODULE MARK SCHEMES 

 
PMOD01 (automatic condonement) and PMOD02 (automatic referral) — New PGT module mark scheme 
*   PMOD01 default  ** PMOD02 default 
 
Initial assessment 
This table outlines which grade SITS will automatically assign to a module mark when the result is calculated in SAS option 6, based on a combination of the 
component mark schemes assigned in MAB as well as the module mark scheme assigned to the module in the MAV screen.  
 

Module result 
as calculated 
by SAS option 
6 

Grade Meaning Details Notes 

70-100 D Distinction  
 
Module completed and student awarded 
credits 
 

 

60-69 M Merit  

50-59 P Pass  

0-49 FC * Fail (condoned) A maximum of 45 credits per year can be condoned 

for a Masters award if the student’s overall credit-
weighted average is 50+. 
 
If the component mark scheme is set to PCOM02 on 
all components on MAB, this will override PMOD01 
and module result will be treated as PMOD02.  

0-49 FR ** Fail (Refer) Result is treated as a fail and will go into 
reassessment 

If this was the student’s deferred attempt (chance 
to sit assessment again for uncapped mark) — 
grade of FR will be applied to component as student 
allowed 2nd attempt at module if failed overall. 

 
For a list of grades that can be manually applied to module results, see the Mark Entry notes on the SITS > Course Notes site. 
 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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Reassessment 
This table outlines which grade SITS will automatically assign to a module result when calculated in RAS option 5a, based on the component mark scheme 
assigned to the assessment pattern in the MAP screen > Re-ass MKSCH field.  
 
*   PCOM01 default     
** PCOM02 default 
 

Module result as 
calculated by 
RAS option 5a 

Default grade 
assigned by 
SITS  

Meaning Details Notes 

50-100 P Pass  Module completed and 
student awarded credits 
 

 

0-49 * FC Fail (condoned)  Module completed and 
student awarded credits 

A maximum of 45 credits per year can be condoned for a Masters 
award if the student’s overall credit-weighted average is 50+. 

0-49 ** FR Fail (refer)  Module completed and 
student is not awarded 
credits 
 

If this was the student’s deferred attempt (chance to sit 
assessment again for uncapped mark) — grade of FR will be 
applied to component as student allowed 2nd attempt at module if 
failed overall. 
Reassessment record will need to be created in next academic 
year. 

0-49 ** F Fail — Credits not 
awarded to 
student 

Module completed and 
student is not awarded 
credits 

If this was the student’s referred (2nd) attempt (chance to resit 
assessment for capped mark) — grade of F will be applied to the 
component (no condonement, no reassessment). 

 
For a list of grades that can be manually applied to module results, see the Mark Entry notes on the SITS > Course Notes site. 
 
 

UG and PGT component mark schemes: PFCOM (pass/fail only, no numerical mark entered)  
 
Initial assessment or reassessment 
This table outlines which grade SITS will automatically assign to a component mark when entered in SAS option 3, based on the component mark scheme 
assigned to each individual component in the MAB screen.  

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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Grade entered in SAS option 3 Meaning 

P Pass  

F  Fail  

 
For a list of grades that can be manually applied to module results, see the Mark Entry notes on the SITS > Course Notes site. 
 

APPENDIX 2 — LIST OF COMPONENT AND MODULE GRADES (MANUAL ENTRY) 
 
When entering component marks into SAS option 3 or RAS option 2a, SITS will automatically assign a grade based on the component mark scheme that is 
associated to the component in the Module Assessment Body (MAB) record or in the MAP screen. See the ‘Module Assessment and Reassessment Set-Up’ 
notes on the SITS > Course Notes site for details. 
 
When calculating a module result at initial assessment (SAS option 6) or reassessment (RAS option 5a), SITS will automatically assign a grade to the module 
result based on a combination of the component grades and mark scheme attached to the module in the MAV screen. See the ‘Module Assessment and 
Reassessment Set-Up’ notes on the SITS > Course Notes site for details. 
 
These automatically allocated grades are listed in Appendix 1 (above), according to the mark schemes. 
 
It is possible to override the grade assigned by SITS either in SAS option 3 or once the module result has been calculated, via the SMRU screen. Here is a 
list of valid grades that can be manually applied: 
 
 

Grade Meaning Details/when used 

AB Absent Student did not show up for an assessment (e.g. exam, group presentation). 

AO Alleged Offence Student is suspected of/being investigated for an academic offence such as plagiarism, cheating, etc. 
 
AO is a holding grade and should never be left against a student’s record. Once the outcome of the investigation is known, the grade should be 
amended to reflect the module outcome (e.g. F, FR, FC, etc.) 

F Fail Student will not be awarded the credits and a reassessment record will not be created.  

FC Fail Condoned Used at UG level only, at component level. 
 
Used at UG and PGT level, at module level. 
 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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Student is awarded the credits. 
 

FR Fail Referred Used at UG level only, at component and/or module level. If applying at a module level, you also need to specify which components should be 
referred, so that SITS knows how to create the reassessment records/how to refer the student. 
 
If the module is failed overall (less than 40%), student offered 2nd attempt at module, based on reassessment pattern set up, for capped 
module mark of 40%. 
 
Student is not awarded the credits. 
 

H Held Used to hold the module outcome if awaiting other results. Credits are withheld. Grade will need to be updated once the outcome is known. 
 
Example: You do not wish to apply a grade of FC to a PGT module in June until the dissertation result is received in October, at which point you 
can determine whether the module can truly be condoned (FC). 
 

I Interrupted Placed against component and module marks if student has interrupted his/her studies while enrolled on the module.  You may have to apply 
the grade of I against all components in order for it to be applied at a module level. 
 
Student will be awarded/not awarded the credits, according to whether the module is passed or failed. 
 
Module should also be superseded in SMRS (apply a value of S to the Selection field for the module/year in question). 

LS Late Submission Used to highlight a late submission.  This is rarely used. 

MI Mitigation  Placed against a component that the student has had a deferral approved for. Student is able to re-take the deferred component as if for the 
very first time, for an uncapped module result. 
 
The presence of a grade of MI against one or more components will override the entire module result. 
 

 UMOD01/UMOD02 and PGTMFC mark schemes — will automatically defer the student (create a RAS/SRA record at attempt 1) 
according to the module assessment/reassessment set up,  

 Other module mark schemes — will defer the student if the module is failed overall. 
 

NS Non Submission Used if the student does not submit an assessment. 
 

NT Not Taken Can only be used in conjunction with certain mark schemes and can only be used at a component level. 
 
Used when a student has not taken an assessment due to failing another component. The placement is this grade will automatically generate a 
reassessment record (at attempt 1) when the module result (SAS) is calculated. 
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OP Optional Pass Used at PGT level only. Means that the module is being condoned. This grade will only be used in the exceptional instances where the PGTMOD 
marks scheme is applied (refer to PGMFC Mark Scheme for exception details) 
 
Applied at a module level to condone a module if the result is between 40 – 49, thereby awarding the credits to the student. 
 

W Withdrawn Placed against component and module marks if student has withdrawn from his/her programme of studies while enrolled on a module.  
 
Student will be awarded/not awarded the credits, according to whether the module is passed or failed. 
 
You may have to apply the grade of W against all components in order for it to be applied at a module level. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

APPENDIX 3 — MARK ENTRY PROCESS MAP  
 

http://as.exeter.ac.uk/media/level1/academicserviceswebsite/it/documents/sitscoursenotes/PGTMFC_Mark_Scheme.pdf
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APPENDIX 4 — ERROR MESSAGES/TROUBLESHOOTING ISSUES IN SAS SCREEN 
 

SAS option 1b 
 
Unable to generate SMR record for a student 
 
Explanation: The SMR record can only be generated for a student who also has a SMO (module 
taking) record for that module. 
 
Solution: Check that all the information on the student’s SMO record is as you would expect. For 
example, check the academic year field, check the occurrence of the module and ensure that the 
selection criteria at the top of the SAS screen correspond with the fields on the SMO record. Also 
ensure that if you have entered a particular assessment group in the SMO for that student (i.e. value 
in the AG field), that an entry for that group exists in the MAB record (Agr field). For more details on 
assessment groups, see the Module Assessment and Reassessment Set Up course notes on the SITS 
Course Notes site. 
 
Module has a previous SMR which is not complete. SMR not created 
 

 
 
Explanation: There is a SMR record for this module and student in a previous year that has not been 
completed, i.e. in the SMR screen, the Cur Pro field is set to SAS or RAS for this student/module, 
instead of COM. 
 

 
 
Solution: Complete the SMR record via the SAS or RAS screens as appropriate. 
 
 
 
 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
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No SAS or SMR records created for this student (possible Agrp mismatch) 
 

 
 
Explanation: There is a mismatch between the SMO record and MAB record in terms of the 
assessment group. The SMR record can’t be generated because SITS is unsure as to what 
components to generate for the student. Either the student has been allocated to an assessment 
group on SMO that does not exist in MAB or the student has not been assigned to an assessment 
group in SMO (or been assigned to the wrong one) — does not correspond to MAB record. 
 
Solution: Check the AG field in the SMO screen for that student and compare against the Agr field in 
the MAB record and updated as appropriate. For more details on assessment groups, see the 
Module Assessment and Reassessment Set Up course notes on the SITS Course Notes site. 
 
 
Error finding scheme, level, credits or mark scheme, please check MAV and MOD records for XXX 
 
 

 
 
Explanation: Check the MAV record and ensure that there is a mark scheme noted against it and 
correct as needed. 
 
Solution: If the MAV is correct, contact the Student Records team. It may be that a field was not 
correctly populated on the MOD screen when the record was created.  
  
 

SAS option 3 
 
Mark/Grade combination not valid for mark scheme 
 
The following message appears when you enter a grade against a mark in SAS option 3. 

http://as.exeter.ac.uk/it/systems/sits/howdoi/coursenotes/
mailto:sr-admin@exeter.ac.uk
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Explanation: The combination of mark and grade is not a valid combination for this module. 
 
Possible solutions: 
 
1. Check appendices 1 and 2 of this document and look up valid grade combinations for the mark 

scheme mentioned in the error message.  
 

2. If the Grade field is not populating automatically or not allowing you to input a valid grade, 
ensure that the Get Grade from Mark field is set to Yes in the following screens: 

 

 MAP > More Details (or MAPS) 

 MAB > More Details (or MABS)  
 

If in doubt (or the above does not resolve the issue), get in touch with your SITS support contact.  
 

SAS options 4 or 5 
 
“Programme ‘CAM_XSAS_IMP’ not available. $Status=0” error message 
 
Explanation: You do not have access to those options. 
 
Solution: Log a SID call, selecting the following category and sub-category: Software & Applications > 
SITS & SRS Request Form (in question 1, specify that your existing access needs to be amended). 
Request access to options 4 and 5 in the SAS screen. 
 

 
SAS option 6 
 
MKC: Mark/Grade 56=P attempt=1 cannot be found on XXX scheme or ….. – assessment grade (P) 
not found 
 

 
 
Explanation: Since you have entered the mark, the component mark scheme relating to the module 
has changed. The combination you have entered is no longer a valid combination for the student of 
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whom the candidate number is shown in the error message. Or the component and module mark 
schemes are clashing. 
 
Solution: Report the issue to your SITS support contact for resolution. 
 
Assessment records not complete – result not set 
 
Explanation: One or more component marks are missing for the students listed. All component 
results must be entered in order for a module result to calculate. 
 
Solution: Enter the marks for the component(s) for the student(s) and re-run option 6.  
 
Assessment records not inputted – result not set 
 
Solution: In SAS option 3, for the students mentioned in the error message, delete the mark and 
grade. Store your changes, then re-enter them, store your changes again and try to re-calculate the 
module result (SAS option 6). 
 
AST does not require logging 
 
Explanation: This message is triggered by the creation of a reassessment record for a student when 
the module result is set. It appears if the generate due dates field on the AST record is set to off for 
that particular type of assessment. 
 
Solution: This is not an error message as such and can be ignored. 
 
 
Nothing happens when option 6 run— “No text available in message frame” appears in the Message 
Line 
 

 
 
Explanation: The Tick AgrR box on the relevant MAP record has not been ticked which means that 
the module result cannot be calculated by running option 6. 
 

 
 
Solution: Tick the Tick AgrR box, store your changes and re-run option 6 again. 
 
 
Warning ‘0120’ on field ‘SRA_NAME’ – (sub) field too large, field value shortened to fit 
 
Explanation: SITS uses the MAB_NAME field (the description field on MAB [Module Assessment 
Body]) as the description for the SRA [Student Re-assessment record]. The MAB_NAME field is 120 
characters long, whilst the SRA_NAME field is 50 characters long. SITS will shorten the name to fit. 
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Solution: You will either need to shorten the MAB description text, change the SRA description 
manually to make it more significant, or leave as is. 
 
 
Method of Assessment is not M 
 

 
 
Explanation: The Assessment Method field on MOD is blank. 
 

 
 
Solution: Contact the Student Records team and request that the Assmn’t Method field be updated 
to Module. 
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